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Product at a glance
Product type

French Writing Environment (aka Grammar/Spell
Checker)

Level

Beginning / Intermediate

Media Format

One CD-ROM (or Web download)

Operating Systems
Windows

Windows 95,98, 2000
Mac OS 7.5+ including an OS X version

Hardware requirements

PC: 80486 processor + (Pentium recommended)
Mac: 68020+

RAM

PC: 24 Mb RAM (32 Mb recommended)
Mac: 7Mb RAM

Hard Disk Space

PC: 25 Mb
Mac: 16 Mb

CD-ROM

Any speed, required only for installation.

Sound

Standard 16 bit sound card

Video

Not specified

Documentation

PDF file on CD-ROM

Price:

Sans Faute ISBN: 0-07-247520-X
UltraLingua ISBN: 0-07-247521-8
Individual copy: $55.63 (with Ultralingua)

Individual copy
Lab Pack (20)

$44.50 net to the bookstore for SansFaute,
$34.75Ultralingua
McGraw-Hill Institutional licensing for Sans- Faute:
$531.75(includes Ultralingua)
McGraw-Hill Institutional licensing
for Ultralingua:$423.50

Introduction
Sans-Faute, an integrated writing environment, is a recent entry into the field of French
grammar/spell checkers that includes Le Correcteur and Antidote.[1] Yet, it has some features and an
audience perhaps more akin to those of Système D.[2] McGraw-Hill, its American distributor, lists it at
the Beginning/Intermediate level. While there is a version sold in France that targets native speakers
(even claims that the educational version meets advanced non-native learners' needs), for the
purpose of this review, only the McGraw-Hill version was thoroughly examined. Perhaps Le Correcteur
didactique, the Machina Sapiens version of Le Correcteur 101 specifically designed for non-native
classroom use, corresponds more to the Sans-Faute target audience here in North America. Unlike its
competitors, Sans-Faute comes from a mixed marriage of French and U.S. origin. The
dictionary, Ultralingua[3]has a relatively long history in France under the name, Le Franglophile (more
on this below). The grammar checker results from the work Jean-Pierre Brulé, Philippe Caudron,
Laurent Debrauwer (BCDL-Hexacom, France), Scott Carpenter and Jeff Ondich (Carleton College,
Minnesota, USA). In that Le Correcteur and Antidote have been reviewed in this column of late, to
facilitate the comparison among the three,this review will follow their format as much as possible.
General Description
Summary of Features
Sans-Faute hails itself as an "Interactive Writing Environment" based on an "inferential search
engine, a simple word processor, a comprehensive French-English dictionary (produced
by Ultralingua), and convenient grammatical resources." (Sans-Faute documentation 3.5, p.2). It
actually is two packages that have been coordinated to work well in tandem with occasional overlaps
and rare incompatibilities. With all three environments open, i.e., the word-processor, the grammarchecker and the dictionary, the user's interface might look like this on a Macintosh:

The inferential search engine functions as part of the grammar checker. Its job is to reduce syntactic
ambiguities by detecting the most appropriate grammatical circumstance that obtains for the given
context. For example, where "le" may function as either definite article or direct object pronoun, its
gender and position provide disambiguating information to the engine. Yet, before the search engine
performs its functions, the grammar checking process begins with a spelling analysis. The successive
sweeps are ordered as follows:
1.
2.
3.
4.
5.
6.

Spelling
Missing hyphens
Grammatical incompatibilities
Agreements within noun clusters
Subject-verb agreement
Past participle agreement

7. Agreement of predicate adjectives
8. Elision (contraction) and separation
9. Verb tense/mood choice
10. Irregularities and stylistic errors.
Through the Preferences option under the "Edit" menu, the list of grammar and punctuation checking
functions can be modified (more on this below).
The menu items in Sans-Faute are labeled in English as: File, Edit,Text, Lexicon, Checking, Windows,
Help.
The "File" menu offers the standard items. The "Edit" menu, too, is standard but includes an item (in
the Macintosh environment) to "Check the Clipboard" (from a previous copy/paste action), allowing
the user to re-paste the corrected text easily back into another software package. It also contains the
"Preferences" item. The three submenus are: General, Grammar Alerts, and Punctuation. These
control the levels of specificity for corrections, styles, and some operations (e.g. to quit the software
when all windows are closed). "Text" controls font and formatting. "Lexicon" involves the opening and
changing of lexicons, either opening or changing the one accessed through Sans-Faute. New words
can be added to one's lexicon. "Checking" offers menu options for working through the spelling and
grammar correction in various fashions. It offers "Global checking" to tag all errors in the edit area,
spelling in red (coloration is deleted when the text is removed from the edit window), followed by the
item to "Remove error marks". "Stop without modifying" stops a checking session between SF and
another application: changes already made are discarded. The next set of commands may be
executed from the buttons on the main window and include the "Check" command, one to open the
conjugator, another for a list of plural noun forms, and another for opening or changing the dictionary
(a drop down menu on the edit window). One can choose to check spelling only, do a quick search for
errors (takes less time but decreases accuracy), or toggle on/off the punctuation checker (the degree
of specificity and FR/ENG norming of which is set in preferences). Many of these items have
corresponding keystrokes. The "Windows" menu lists all SF windows currently open and the "Help"
menu in Macintosh offers the Balloon toggle as well as access to the "Users Guide". The "User Guide"
may be opened while one is in the text editor. It offers the same information as the PDF users manual
that accompanies the software.
The grammar norm is not specified in any of the literature to which I had access. It certainly does not
have the depth of the Grevisse Bon Usage that underpins Antidote. Indeed, the PDF documentation
and the on-line suggestions are written in English--unlike both Le Correcteur and Antidote--and are
thorough enough for beginning to intermediate learners though not sufficiently sophisticated for
advanced learners. The grammar documentation (pp.20-31) coupled with the grammatical glossary
(pp. 36-38) offer a succinct non-native writer's guide for grammatically sound writing and for editing
errors. Additionally, it proffers sage advice such as: "It is preferable - indeed, recommended - that the
user read the suggestions with a mind to perfecting his or her command of the language." (p. 19);
and, in Ultralingua, "Always check your translation with the reverse translation feature. This allows
you to confirm the appropriateness of your choice. It also allows you to check on the gender of French
nouns, and it will often lead to new possibilities."(p. 35).
The connection to a broader, more in-depth, hypertextual reference grammar forms part
of Ultralingua where it is accessible from the "Appendices" menu (in Windows, it is called "Help";
through Macintosh preferences, one can choose the language of the menu bar; hence, in the French
version it becomes "Annexes") and the toolbar. In the Sans-Fauteenvironment it is reached through
the Ultralingua FR-EN button on the main SF window. It offers a French grammar for English speaking
students and an English grammar for French speakers. The hypertextual index offers 101 selections
arranged alphabetically from Adjective Agreement to Vouloir. Inside the grammar explanation--in
relatively simple English--, there are hyper-textual links to related aspects and suggestions to visit
those links to flesh out one's grasp of the rules. The most recent version of this accessory hosts a
floating toolbar that allows access to the dictionary, a number converter, a handy search engine (with
wildcard options), the references (the UL manual plus grammar reference, tables and letter
templates), and an Internet connection to the www.Ultralingua.com site. The performance of this

utility continues to improve: this past year, the product has seen impressive enhancements to what
was already a very effective program.
The word processing environment has features similar to both Antidote and Le Correcteur. It appears
to be plagued by the hard return problem (end-of-line markers may be read as sentence terminations
by SF unless painstakingly removed prior to running a check). Users may create their own document
in the text editor window (in the Windows environment, one can import/export freely from Word but
surprisingly not on a Mac in whose OS this software originated!). The on-line text editor does not
provide fancy formatting but that may, of course, be added in a more robust text editor after the text
has achieved its improved grammatical and orthographic soundness in Sans-Faute. Otherwise, text
can be imported as text-only (SimpleText or TeachText in the Macintosh world) or "styled text."
Though not visible within the Sans-Faute interface, imported texts with color, formatting and font
changes are preserved when exported back to a word processor. Boldface, italics, and underlining do,
however, convey and display. On a Macintosh, Sans-Faute can maximize drag and drop functionality
as well as having the option under the "Edit" menu to run a grammar/spell check on the clipboard.
Through Apple Script or Apple Event, the commercial version of Sans Faute (but not the educational)
can eventually hook into eighteen different email and text editing programs.
What is interesting is the Sans-Faute functionality to act as a desk accessory for grammar reference or
for dictionary/thesaurus consultation or both, in addition to its being a full-fledged program for textediting and grammar/spelling checking.
There are two dictionaries: the spelling lexicon that is completely integrated into the software
and Ultralingua which comes as an accessible stand-alone program. It is a bilingual dictionary and
thesaurus. The Ultralingua module, as noted above, can act as a desk accessory and may be used
without booting Sans-Faute. Otherwise, one can opt to access two other dictionaries from within the
grammar checker if one has purchased them: the Microsoft Bookshelf or Le Petit RobertÉlectronique.
Only in rare instances do the two dictionaries not complement each other well (see below).
Currently, McGraw-Hill offers only the French-English version of Ultralingua. The Ultralingua site now
offers bilingual Spanish-English, German-English, Portuguese-English, Italian-English, French-German,
and Spanish-French versions as well as a French-English Medical dictionary. There are also two
monolingual dictionaries: English (Collegiate) and French (150,000+ entries). All are available in
Windows, Macintosh and in very affordable Palm versions. There is mention of text-to-speech
functionality for both Macintosh and Windows. I have used the installed speech function of SimpleText
to listen to a phrase in English. Apparently, a Mexican Spanish version exists, too. For Windows, one is
advised thatUltralingua works with any SAPI compliant speech engines. For other languages, BCDL
recommends the Digalo SAPI engines from http://www.digalo.com.
There are two user manuals, a fact which I found confusing at first. The first manual targets the set up
and functioning of the dual program, i.e. both Sans-Faute and Ultralingua; the other is primarily a
grammar reference manual located in the Help (Windows) or "Appendices/Annexes" (Macintosh) menu
of the Ultralingua dictionary, where it, too, contains installation directions, but only for Ultralingua.
Both are clearly written with examples. Installation instructions in the SF Users Manual in both
environments are easy to follow as are the navigation and menu explanations. Perhaps what added to
my confusion is that both manuals contain grammatical rules and grammatical glossaries. The UL
grammar, however, is offered for both languages (English and French) and goes into much greater
depth with its integrated hypertextual links.
Evaluation
Comparison with Le Correcteur 101 and Antidote
I have tried to use benchmarks similar to those of Burston and Mogilevsky (op. cit.) to provide readers
grounds for equitable comparison of all three packages. Still, there are disparities. For example, I base
most of my examples and statistics on tests run on a 500mz, 128MB RAM, G3 iMac; a 400 Mz, 64 MB
RAM, G4; and a 400mz, 256 MB RAM, G3 iBook. I ran it on OS 8.5, 9.1 and under OS X (running
Classic 9.1 since it is not OS X native). Burston ran his tests on both an 8500 Mac (OS 8.1) and a 166
Pentium. The more immediate problem is that the packages are targeted at different audiences. Le

Correcteur and Antidote were conceived in Canada for native speakers; the educational version
ofSans-Faute targets FSL learners, and, then, an audience with beginning and intermediate , not
advanced or superior, proficiencies.

The relative ease of installation is comparable. All three are reasonably easy to set up and, where
necessary, to uninstall. The user interfaces, on the other hand, are quite
different. Le Correcteur and Antidote are entirely in French whereas theSans-Faute educational version
is entirely in English (with optional French for Ultralingua). (One could, most probably, buy the
French-for-French version from BCDL's site to get an all-French version.)

The more important comparison, nowadays, involves the program performance. I have used three of
the same corpora as Burston and Mogilevsky. I began by running the passage drawn from Théophile
Gauthier's "Le Capitaine Fracasse" through the educational version of Sans-Faute, where
unsurprisingly, there was virtually no correction: the engine simply found the sentences too complex,
hence was unable to analyze them for anything other than spelling mistakes (of which there were
none but the vocabulary of which posed problems). Therefore, any comparison of the time it took
(almost immediate in SF and Antidote vs. Le Correcteur's four to six minutes) obscures the inability
of Sans-Faute to deal with the text. Still, Sans-Faute does not aspire to superior, native speaker
users. For this reason, I have not included here the data from the Badinter article from Le Monde that
Burston tested.

With the same 40 essays by intermediate proficiency writers that Mogilevsky and Burston used in their
reviews, we get a more useful picture of the performance of the packages on non-native writing
samples: the environment in which a spelling/grammar checker will be called upon to perform most
often for most of us. Let us begin with the specific writing sample from this corpus as found in
Mogilevsky's review:

Le film le plus reussi que j'ai vu cette annee c'est la seance d' "Une Pure Formalité".
Ce film, tres bizarre, avait la puissance qu'on ne trouverait pas dans un film
ordinaire. Gerard Depardieu, comme le charactere principal, etait excellente dans sa
role.
Quand le film etait mis en oeuvre je me trouvais devenir confuse parce que le
scenario progressait très rapidement, entre les scènes. On ne pouvait pas concentrer
sur les evenements individuellement, et il etait difficile de tenir l'histoire. Pour qu'on
ait été pu comprendre l'histoire, il devait attendre jusqu'à la fin du film. Donc, c'etait
la fin du film qui etait la plus importante.
Certainement l'essence de ce film remarqable etait revélé à la fin.
Sans-Faute in spelling-only mode was able to identify correctly sixteen spelling errors. It had a
particular problem with "evenement" for which it offered "avènement" as its only suggestion. Still,
with Ultralingua open, a quick (although perhaps meta-conscious, learned) search immediately
produced the appropriate "événements". On the next sweep, the grammar checker noted four
potential errors, two correctly, two falsely. It suggested that the verb of the third sentence ("Gerard...
.") might be plural. It also suggested that the noun for "la plus importante" in the seventh sentence
might not be feminine, thus posing an agreement problem. It correctly queried the gender discord
between "sa" and "rôle" (third sentence) and "essence" and "revélé" in the final sentence. It missed,

obviously, the "je me trouvais devenir confuse", "Gerard", "était excellente", and "Pour qu'on ait été
pu".
Here is the SF corrected version:

Le film le plus réussi que j'ai vu cette année c'est la séance d' "Une Pure Formalité".
Ce film, très bizarre, avait la puissance qu'on ne trouverait pas dans un film
ordinaire. Gerard Depardieu, comme le caractère principal, était excellente dans son
rôle.
Quand le film était mis en oeuvre je me trouvais devenir confuse parce que le
scénario progressait très rapidement, entre les scènes. On ne pouvait pas concentrer
sur les événements individuellement, et il était difficile de tenir l'histoire. Pour qu'on
ait été pu comprendre l'histoire, il devait attendre jusqu'à la fin du film. Donc, c'était
la fin du film qui était la plus importante.
Certainement l'essence de ce film remarquable était révélée à la fin.
Mogilevsky working on the same chunk of text using Le Correcteur, versions 2.0 and 3.5, noted that
version 3.5 found and corrected only two errors in automatic correction mode. In 'detection only'
mode, nine spelling/diacritical errors were discovered. The 2.0 version fared much better, correcting
20 accent and spelling mistakes and one adjective gender agreement mistake, and flagging one
diacritical, two spelling and two conjugation mistakes. Under interactive correction mode, the
performance of Versions 2.0 and 3.5 were nearly identical and flagged many more errors. I ran the
same text through Le Correcteur Didactique which proved to be the best performing (it is also more
recent that 3.5) . It flagged all the spelling/diacritical errors, caught the grammatical errors (including
the "ait été pu" though it allowed for a grammatically sound, albeit temporally discordant, "ait eu pu"),
and called upon the user to look up "confus" and "événements". Its single mistake: suggesting that
"concentrer" be edited to a past participle. None of the checkers marked the "me trouvais devenir
confus" which would be expecting too much of them (as it is of many of our learners!). What I quickly
noticed is that the Correcteur Didactique interface makes the learner do all the work. It does not offer
the easy click to correct functions of Sans-Faute and Antidote. For this reason, it may be more
didactically palatable to certain teachers, perchance in an inverse porportion to the degree to which
students would, then, find it more off-putting. Here then is the text as corrected by the Correcteur
Didactique:

Le film le plus réussi que j'ai vu cette année c'est la séance d' "Une Pure Formalité".
Ce film, très bizarre, avait la puissance qu'on ne trouverait pas dans un film
ordinaire. Gérard Depardieu, comme le caractère principal, était excellent dans son
rôle.
Quand le film était mis en oeuvre je me trouvais devenir confus parce que le scénario
progressait très rapidement, entre les scènes. On ne pouvait pas se concentrer sur
les événements individuellement, et il était difficile de tenir l'histoire. Pour qu'on ait
eu pu comprendre l'histoire, il devait attendre jusqu'à la fin du film. Donc, c'était la
fin du film qui tait la plus importante.
Certainement l'essence de ce film remarquable était révélée à la fin.

Le film le plus réussi que j'ai vu cette année c'est la séance d' " Une Pure Formalité". Ce film, très
bizarre, avait la puissance qu'on ne trouverait pas dans un film ordinaire. Gérard Depardieu, comme l
caractère principal, était excellent dans son rôle.

Quand le film était mis en oeuvre, je me trouvais devenir confuse parce que le scénario progressait tr
rapidement, entre les scènes. On ne pouvait pas se concentrer sur les événements individuellement, e
était difficile de tenir l'histoire. Pour qu'on ait été put comprendre l'histoire, il devait attendre jusqu'à
fin du film. Donc, c'était la fin du film qui était la plus importante.
Certainement, l'essence de ce film remarquable était révélée à la fin.
Antidote, set in the lowest "locuteur" setting (for non-natives), found all spelling errors and the
majority of grammatical errors. It even queried the use of "concentrer sur" which a student might be
able to correct from the dictionary entry on "concentrer". It wrongly suggested that "difficile" be
followed by "à" rather than "de". In my perusals of the grammar and dictionary entries, I was unable
intuitively to locate counter examples or rulings for an appropriate usage. It also recommended that
"ait été pu" become "put", again with neither clear nor easy examples and, obviously, not catching the
underlying error. The corrected text became:

The law of least effort dictates that students, if not all of us, tend to use what is most readily
available. In that Microsoft now bundles foreign language spelling and grammar checkers with MS
Word and Office, I discovered in trialing these software packages with students that they arrived in
their composition courses with their texts already checked by Microsoft. Therefore, I am including a
version of this same student text as corrected by the Word facility.[4] The Office 2000 version that I
used found 18 spelling errors and corrected the agreement of "révélée" and "son rôle". It incorrectly
queried the "parce" of "parce que" suggesting substitutions like "parc". Here is its corrected version:

Le film le plus réussi que j'ai vu cette année c'est la séance d' "Une Pure Formalité". Ce film, très
bizarre, avait la puissance qu'on ne trouverait pas dans un film ordinaire. Gérard Depardieu,
comme le caractère principal, était excellente dans son rôle.
Quand le film était mis en oeuvre je me trouvais devenir confuse parce que le scénario progressait
très rapidement, entre les scènes. On ne pouvait pas concentrer sur les événements
individuellement, et il était difficile de tenir l'histoire. Pour qu'on ait été pu comprendre l'histoire,
il devait attendre jusqu'à la fin du film. Donc, c'était la fin du film qui était la plus importante.
Certainement l'essence de ce film remarquable était révélée à la fin.
Based on this trial, Sans Faute fares well among all four packages. Yet, Le Correcteur Didactique
proved the most precise, but it forces learners to work painstaking ly. The ease and availability of the
MS-Word add-on makes it, perhaps, the student choice.

For a broader view of performativity, all forty compositions tested by Burston and Mogilevsky were
submitted to the Sans-Faute environment. Whereas Correcteur found a total of 91% of the 1, 262
errors and Antidote 82% (Burston, p.9), Sans-Faute would appear to have 91%, too.[5] Undetected
mistakes in Correcteur were 2%, in Antidote 7% and in Sans-Faute, 8%. Sans-Faute provided few
flagged errors without suggestions, only 1%; however, it incorrectly suggested remediations some 63

times. Still, Sans-Faute holds its own with both Antidote and Le Correcteur. In fact, I prefer it
pedagogically for the onus it puts on the beginning/intermediate learner to reflect on errors and for
the numerous support systems (the conjugator, the plural forms, the UL dictionary, the reference
grammars) with which to do so successfully. If one considers SF a writing environment for FSL
learners, it offers a more supportive environment that the other two. If one is looking for a more
advanced usage editing tool and grammar/spell checker, SF proves less robust.

Where Sans-Faute proved less effective was in sentences with several errors. It simply gave up and
noted the sentence as too error ridden. SF consistently registered problems with "même": being
unable to make gender agreements in its presence. Similarly, it had difficulties finding agreement
errors of post nominal adjectives ("les types certaines du chocolat", "action plein", "niveau plus
haute", "sujet actuelle", for example). "Peut être" without a hyphen brought out mistaken
suggestions. Occasionally, the suggestion box proposed incorrect verb agreements, calling for a
change from a singular to a plural or querying if there might not be a different verb ending for an
erroneously identified subject: this would definitely disconcert beginning and intermediate learners.
Sometimes, however, it seemed that the suggestion window simply got stuck and left a former
explanation visible. Frequently, the auxiliary verb of a passé compose was highlighted for its
stylistically undesirable repetitiveness. Every once in awhile, and I found no rhyme nor reason to it,
the suggestion box would display code or double part of the correction while leaving out another part
("du franglaise" incited "franglaisefranglais" and "franglaise" as options and "de la racisme" brought up
"racismeracisme" and "5-¡acisme"). These problems need to be fixed by the developers. I am
confident that they will do so, given that my draft review of this software met with immediate
corrections.

In its favor, the Sans-Faute interactive grammar catches those superfluous, Anglophone prepositions
(with écouter,attendre, etc.) , those irritating subject pronouns for disjunctives, misplaced object
pronouns, inappropriate use of fairefor rendre, and it correctly suggests prepositions between a verb
and an infinitive and after certain prepositions (avant, for example). The conjugator , plural finder,
and the Ultralingua utilities are, indeed, very powerful for the Anglophone novice/intermediate writer
and much more so than Système D which lacks interactivity. Students would need to learn to use
them successfully in an orientation session, but such a lesson would well serve them through the rest
of the language acquisition process.
Summary
Many students will opt to use the Word package despite what is clearly lesser performance by dint of
the law of least effort and student economics. This fact may encourage the companies to make their
pricing more competitive or to seek bundling agreements. This is especially the case in lab pricings
and/or multi-user licenses. Still, all four grammar checkers have functions that teachers and students
can exploit to improve writing and editing skills. Regardless of the package, such improvement will
depend on self-activated learner strategies resulting from well-orchestrated, instructor-guided
orientation to the software in relation to the writing/editing process. Sans-Faute is well-suited to
educational environments that rely on English to facilitate this learning and orienting process. The
grammar explanations in the manual and theUltralingua grammar are succinct and useful. Their
directions to careful editing and use of the packages, too, are large steps in the right direction (if the
learner's attention is focused on them). The Ultralingua desk accessory is well-conceived and very
handy for all levels of users. I use it regularly and appreciate having it on my desktop. In sum,
then, Sans-Faute, as an FSL writing environment, is currently the most powerful on the market.
Scaled rating (1 low-5 high)
Implementation possibilities: 5
Pedagogical Features: 4
Use of computer capabilities: 4
Ease of use: 5

Over-all evaluation: 4+
Value for money: 3
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[1]

See CALICO Software Reviews and Reports of Le Correcteur 101, Jack L. Burston "A Comparative
Evaluation of French Grammar Checkers" (CALICO Journal, 13, 2-3 1995-1996) and Eugene
Mogilevski, CALICO Software Report, "Le Correcteur 101: A comparative evaluation of 2.2 versus 3.5
Pro, (/CALICO_Review/review/c10135.htm; 9/98); and ofAntidote, Jack Burston , CALICO Software
Report , "Antidote 98" (/CALICO_Review/review/antidote00.htm; 1/99)

[2]

Mikle D. Ledgerwood, " Système-D: Writing Assistant for French", Calico Software Review
(/CALICO_Review/review/systemed00.htm; 2/00).

[3]

The name of Ultralingua may prove confusing: the French version and its site are either Ultra
Lingua or UltraLingua. The American version has opted for Ultralingua.

[4]

It would be useful to run a year long test of these four checkers plus Système D on beginning,
intermediate and advanced students in order to report on pedagogical strategies for integrating them
successfully into second language writing acquisition, taking into account student learning style
preferences.

[5]

Although Burston and I tried to coordinate our correcting techniques and categories, and despite
five arduous efforts on my part, I never managed to exactly correlate our statistics. To compensate,
then, I have taken the percentages of undetected and misidentified errors in the field of 1262 total
errors from my talley to arrive at a comparable "Detected" percentage that can be compared to theirs.
What further complicated the compatibility of our talleys is the functionality ofUltralingua, which, if
used well, significantly reduces spelling errors.
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